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e-Contacts EP instructions for Outlook 2010 

1. General  

2. Closing a prior version of e-Contacts EP in Outlook 

3. Opening e-Contacts EP in Outlook 

4. Using the predefined list views  

5. Creating custom views  

6. Copying and exporting lists   

7. Group mailings  

7.1 Creating mailings or printing labels in Word  

7.2 Group Faxes  

7.3 Group E-mails 

 

 

1. General 

These instructions describe how to install and use e-Contacts EP. They are based on Microsoft Outlook 2010.  

Mailings through e-mail, fax, printout, etc. depend on your installations. Below, we describe various 

methods of selecting and preparing data for mailings and other purposes. 

Instructions assume the user‟s basic general familiarity with the Microsoft Windows environment and with 

basic standard operations such as “drag-and-drop”, “cut-and-paste”, use of menus and dialogue boxes, etc.  

e-Contacts EP is an “outlook data file” file (.pst), the standard format used and created by MS Outlook. Its 

use follows the standard Outlook procedures, as described in Outlook Help (accessible e.g. by pressing the 

“F1” function key on your keyboard). e-Contacts EP is also available in alternative formats (Excel, Access, 

CSV) which are compatible with other database and communications softwares. 

If at any point you have a question not answered by this documentation or Outlook Help, you may:  

 Check the Microsoft Office Outlook site: 
http://office.microsoft.com/en-us/outlook/FX100487751033.aspx 

 E-mail questions to: econtactsep@eamonnbates.com  

 

Important: New useful information has been added to this version of e-Contacts EP! You will now find 

information about MEPs working in the “Other Bodies” of the European Parliament:  

- Conference of Committee Chairs 

- Conference of Delegation Chairs 

- Parliament’s Bureau 

- Conference of Presidents 

- Quaestors 

http://www.econtacts-ep.com/instructions.html#general
http://www.econtacts-ep.com/instructions.html#using_list
http://www.econtacts-ep.com/instructions.html#custom_view
http://www.econtacts-ep.com/instructions.html#exporting
http://www.econtacts-ep.com/instructions.html#group_mailings
http://www.econtacts-ep.com/instructions.html#creating_mailings
http://www.econtacts-ep.com/instructions.html#group_faxes
http://www.econtacts-ep.com/instructions.html#group_emails
http://office.microsoft.com/en-us/outlook/FX100487751033.aspx
mailto:raxford@eamonnbates.com


e-Contacts EP 
 
 
 
 
 

2 
 

All the information about MEP Activities (i.e. Committees, Delegations, Other Bodies) has been organized in 

a way to make the product easy to use. Activities are categorized as follows: 

- Names of Committees are preceded by “C - “; 

- Names of Delegations are preceded by “D - “; 

- Names of “Other Bodies” (see list above) are preceded by “O – “. 

 

 

2. Closing a prior version of e-Contacts EP in Outlook  

If you are installing e-Contacts EP for the first time you can skip this section and go straight to chapter 3. 

Although new versions of e-Contacts EP may co-exist with older ones, it is recommended you delete old 

versions from both Outlook and your hard disk.  

However, if you have entered your own data into the old Outlook file, this will also disappear. In this case, it 

will, therefore, be necessary to keep and manually transfer this information.  

1. Make sure that the Folder List is visible.  

2. In the Folder List, right-click on “e-Contacts EP xxxx.x” and 

click on “Close e-Contacts EP xxxx.x”.  

3. To delete the old e-Contacts EP file from your hard disk, make 

sure Outlook is closed and then delete the old version of e-

Contacts EP from your custom location.  

If you are sharing e-Contacts EP as a MS Exchange Public Folder, select it in the Folder List (under All 

Public Folders) and delete it. This will remove all data from MS Exchange Server.  

 

 

3. Opening e-Contacts EP in Outlook 

Before you can use e-Contacts EP you need to copy the data file to your hard disk and make it readily 

available for Outlook.  

1. Make sure no previous version of e-Contacts EP is open in Outlook. If so, we advise you to close 

and delete it (see chapter 2 above).  

2. Double-click on the outlook file attachment in the email (e-Contacts EP xxxx.x) and save the zip file.  

3. Extract the compressed file and save the outlook data file in a location of your choice. 

4. On the Outlook menu, select the File tab and then Open / Open Outlook Data File… 
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5. Navigate to the folder where you saved the outlook data file, select and open it.  

6. You will see that “e-Contacts EP xxxx.x” has appeared in the Folder List. Click on the Contacts tab 

to view the full list of MEPs. 

7. If you want to share e-Contacts EP as an MS Exchange Public Folder on the network copy it into 

your All Public Folders. You can achieve this by clicking on the “e-Contacts EP xxxx.x” folder and 

dragging it to All Public Folders. 

 

4. Using the pre-defined list of views 

Views can be used for printout, mail merges or for copy and paste 

into other programs. Some standard views are available in Outlook, 

such as viewing “By Category”, which shows the MEPs divided by EP 

Committee, EP Delegation and other EP bodies. You may also 

consider creating a custom view if you would like to select/regroup 

MEPs in a different manner (see next chapter). 

 

To choose a pre-defined view: 

1. Clicking on the View tab and then on Change View will 

display the pre-defined views.  

2. Clicking on an entry will activate that view. 
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Please note: if you are unable to see the “By Category” view among 

the pre-defined views, you can also access it by clicking on 

View/Change View/List and then click on Categories as shown in 

the picture. To save this view, click Save Current View as New 

View… in the Change View dropdown menu. 

 

 

To view assorted contacts, such as members of the Agriculture and Rural Development Committee for 

example, select “By Category” from the “Change View” list box. This will display a collapsed view of all 

MEPs, grouped in the EP Committees they belong to.  (Remember: In each Committee, there is a set of full 

members as in “C - AgricultureRuralDevelopment”, and a set of substitute members as in “C - 

AgricultureRuralDevelopment -S”). 

 

 

To display additional fields: 

 

In addition to the displayed fields (e.g. Full Name, Company (Political Group), E-Mail, Category, Business 

Phone, Business Fax), you may require other fields. To add other fields to the view:  

1. Right-click on the “Column Header Row” (displayed below) and select “Field Chooser” from the 

menu. 

 

2. To make sure to have a choice from all available fields, 

select “All Contact fields” from the Field Chooser drop-down 

list. 
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3. Scroll down, click on “Birthday” for example, and drag it (keeping the left mouse button pressed) to 

the “Column Header Row” where you want to place it. 

 

4. To change the position of a field, drag its heading to another position in the “Column Header Row”. 

5. To delete a field, drag its heading down until it is displayed with an “X”. Drop to delete from view.  

 

To rename Column Headers in a view:  

1. Right-click on the “Column Header Row”.  

2. On the drop-down menu, select “View settings”, followed by “Format Columns”. 

3. Change the entry in the “Label:” field.  

 

To sort by a field:  

Click on the corresponding Column Header. Clicking once will sort by 

ascending; clicking again will sort by descending order (as displayed by 

the arrow). 

 

5. Creating custom views 

If there is a group of MEPs that you communicate with on a regular basis which cannot be categorised 

according to the pre-defined list of views, you may consider creating your own custom view which will then 

be easily accessible via the “Change View” drop down list on your tool bar. 

As an example, we will describe creating a view that displays all “Environment, Public Health and Food 

Safety” Committee Members (full and substitute).  

1. On the Outlook menu: View / Change View / Manage Views…  

2. Select a view you want to base your custom view on – in this case: “By Category”  
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3. Click the “Copy…” button on the right.  

4. In the “Name of new view” field of the “Copy View” window, type “Environment Committee 

Members”. 

5. In the “Advanced View Settings” window, click 

on the “Filter” button.  

6. In the “Filter” window, click on the “Advanced” 

tab.  

7. Click on the “Field” drop-down menu, rest the 

cursor on “the “Frequently used fields” entry, 

and click on “Categories”. The “Condition” field 

is automatically set to “contains”. 

8. Type “EnvironmentPublicHealthFoodSafety”, in 

the “Value” field.  

9. Click the “Add to list” button, and close the 

next two windows by pressing “OK” twice, which brings you back to the “Manage All Views” window.  

10. Press the “Apply View” button.  

The view you have now created displays only Members of the “Environment, Public Health and Food Safety 

Committee” Committee, but note that they are categorised according to the other Committees, Delegations 

and Other Bodies they work in. Although this may be helpful in some cases, you may want a list of the 

Environment Committee which is not further broken down. To achieve this, some more steps are required:  

1. On the Outlook menu click on: View / View Settings…  
2. Click on the “Group by…” button.  
3. In the “Group items by…” drop-down list, select the top 

entry: “(none)”  

4. Close all windows with “OK”. This gives you an 
„uncategorised‟ list of Committee Members.  

 

To create a view of full members of a Committee/Delegation only 

If you would like to view the list of full members of the Environment, Public Health and Food Safety 

Committee only, you will need to further filter the list of MEPs. The required additional steps are the 

following: 

1. In the “Environment Committee Members” view you created following previous instructions, 

click on the View tab and then on View Settings… 

2. Click on the Filter button and then on the More Choices tab. 

3. In the Categories text box, type “C – EnvironmentPublicHealthFoodSafety” (being careful with the 

spacing) 

4. Close all windows with “OK”. This gives you a list of Full Members of the Environment, Public Health 

and Food Safety Committee. 
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5. If you would like to go back to the list of full and substitute members of the Environment, Public 

Health and Food Safety Committee, all you need to do is to un-check the corresponding box in the 

View/View Settings/Filter…/More Choices/Categories window. 

 

 

 

6. Copying and exporting lists 

Any Outlook list may be printed directly from Outlook, copied into a separate Outlook folder for re-use (e.g. 

as a distribution list for mailings by e-mail, fax, print, etc.), and/or copied to a separate application (e.g. 

Access, Excel, etc.). 

Copying a list into an Excel sheet: 

As an example, we will use the “Environment Committee Members” list to create a separate contacts folder.  

1. Make sure the “Environment Committee Members” view is active in the View / Change View list 

box.  

2. Scroll to the top of the list, and select the first entry.  

3. Keeping the “Shift” key on your keyboard pressed, use the arrow keys to scroll to the last list entry. 

This will select all entries.  

4. Press “Ctrl + C” to copy (or right click on the selected list and select “Copy”).  

5. Open a new sheet in Excel and make sure the first field (A1) is selected, and Paste.  

6. A new table is created, with the field labels in the first row.  
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7. Group mailings 

7.1. Creating mailings or printing labels in Word 
To perform a mail merge:  

1. Prepare the letter or label layout you would like to use for your mailing (the so-called “starting 

document”). Save and close the document. 

2. In Outlook, select and mark the recipients you want to send the letter to. 

3. Go to Home / Mail Merge…  

4. Follow the instructions in the “Mail Merge Contacts” window and select the starting document. 

5. The starting document will open automatically. 

6. Now you can insert/modify the greeting line or the address block and finish the mail merge. 

 

7.2. Group Faxes 

Sending a group fax from Outlook to a selected set of recipients depends on the user's fax environment. All 

fax operations, such as setting up and managing recipient lists, including entries that contain more than one 

recipient, will work in exactly the same way as with any other Outlook Contacts data.  

 

7.3. Group E-mails 

An e-mail to a selected group of recipients is an extremely simple operation:  

1. Configure a list view to show those MEPs to whom you wish to send an e-mail.  

2. Select all. You may choose to select or de-select some by clicking on entries while keeping the “Ctrl” 

key on your keyboard presses.  

3. On the Outlook menu, click Home / E-mail. A blank e-mail form with all of the recipients in the 

"To" field will appear. At this point, you may still add or delete recipients before sending the mail. 
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8. e-Contacts EP fields 

In order to make vital fields available for Mail Merge, we changed labels for some fields in Outlook. Below is 

a list of all fields and how these data fields will appear in Word Mail Merge.  

E-Contacts EP Outlook Comment 

Title Title   

First Name First Name   

Last Name Last Name   

Party Department changed label 

Member State Home state changed label 

Group Company changed label 

EP Position Job Title changed label 

EP E-mail E-mail Address renamed 

Brussels fields 

BRU Street Business Street renamed 

BRU Street 2 Business Street 2 renamed 

BRU Street 3 Business Street 3 renamed 

BRU Postal Code Business Postal Code renamed 

BRU City Business City renamed 

BRU Country Business Country renamed 

BRU Office Number Office Location changed label 

BRU Phone Business Phone renamed 

BRU Phone 2 Business Phone 2 renamed 
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BRU Fax Business Fax renamed 

Strasbourg fields 

STR Street 1 Other Street renamed 

STR Street 2 Other Street 2 renamed 

STR Street 3 Other Street 3 renamed 

STR Postal Code Other Postal Code renamed 

STR City Other City renamed 

STR Country Other Country renamed 

STR Office Number Location changed label 

STR Phone Other Phone renamed 

STR Phone 2 Callback changed label 

STR Fax Other Fax renamed 

User data fields 

Language Language 1   

Web Page  Web Page   

Categories fields 

Activities Categories  changed label 

 


